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This presentation provides an overview on how to configure the test tools available in the
Telecom Web services feature of the IBM WebSphere Telecom Toolkit V 6.2. To get a

better understanding on the content of this presentation, review the overview presentation.
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Goal

* Provide an overview of the test tools in the
Telecom Web service feature

= Explains configuration details for testing Parlay X
2.1 client applications.

© 2007 IBM Corporation

The goals of this presentation are to provide an overview of the test tools. It also explains
the configuration of the test tools to test Parlay X 2.1 client applications.
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Agenda

= Simulator configuration
= Simulator configuration editor

» Simulator runtime views

Telecom Web services feature - Confiquration and setup © 2007 IBM Corporation

The agenda of this presentation covers the various test tools which include:
- The Simulator configuration represented by an XML configuration file
- The Simulator configuration editor used to edit a simulator configuration file and

- The runtime views that display the test results and the runtime simulator data when the
application is running.
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Simulator configuration

= Contains configuration values to simulate different
conditions

» Includes test data and Parlay X 2.1 service policies
= Default configuration shipped with simulator

= Create a custom configuration file
» Create using Telecom simulator configuration wizard
» Saving a copy from editable runtime views

Telecom Web services feature - Configuration and setup © 2007 IBM Corporation

The simulator configuration provides various configuration values that include the test data
and service policies defined for various Parlay X services.

The configuration values are used by the simulator to emulate different conditions in
testing user applications. The Toolkit provides a Simulator configuration and uses it as the
default.

You can create a custom simulator configuration file and use it with the simulator instead
of the default. The default configuration is not accessible; but you can create a copy of it
from one of the editable runtime views. The best practice is to create new configuration or
make a copy of the default configuration file and save it under a different name and use
the newly saved file.
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Simulator configuration

= Configuration setting defined in server properties
editor

» Use server properties editor to change configuration

= Copy of default configuration can be created from
runtime views

¥ Telecom Web Services Simulator
Setup simulator.

Use default configuration file

Configuration File: | DefaultwSSConfiguration.wss Browse., .,

Telecom Web services feature - Confiquration and setup © 2007 IBM Corporation

The Ul to change the default configuration is provided in the WebSphere Application
Server properties editor as shown in this figure.

To launch the editor double click on the server in the servers view and expand the Telecom
Web Services Simulator section in the Server properties editor. Un-checking the “Use
default configuration file” check box enables the Configuration File text entry and the
browse button can be used to select the appropriate configuration file from the file system.
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Simulator configuration

= Simulator reads configuration on server startup

= Restart server to use new configuration file

s

Telecom Web services feature - Confiquration and setup © 2007 IBM Corporation

The simulator is deployed and run as an enterprise application in the websphere V6.1 unit
test environment of application developer. The simulator configuration used by the
simulator is read on application server startup. The application server needs to restarted if
the configuration is changed for the simulator to pick up the configuration changes.
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Simulator configuration migration

= Migrate configuration from previous versions

= Steps to migrate from older versions
1. Copy old file into current workspace
2. Double click to open
3. The utility will guide to migrate to current version

Information - the configuration file needs to be migrated to the current version ll

i The selected configuration file is not of a correct version. The configuration will be migrated to the correct version, and opened in the editor. Press OK to display the
SaveAs dialog, and select a fiename to store the migrated configuration.

=]

L
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The format of the simulator configuration in version 6.2 has changed from version 6.1.1
due to the addition of support for new Parlay X Web services.

The configuration files from previous releases need to be migrated to the current version.
To migrate, copy the old simulator configuration file into the current project and double
click to open it. The migration utility pops-up an information dialog, as shown in this slide,
asking you to confirm the migration and guiding you through the steps to migrate to the
current version.
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Simulator configuration editor

= Create or edit simulator configuration data

= Multi-page editor to edit various sections of the
configuration file

» Editor pages include welcome, global settings, account,
group page, services and testing pages

= Saved as an XML file
» Can be viewed using a text editor

= Open editor in two ways:
» Double click on the configuration file in the project
» Right click and use pop-up menu on the configuration file

Telecom Web services feature - Configuration and setup © 2007 IBM Corporation

The simulator configuration editor is used to edit existing simulator configurations or add
new configuration data. It is multi page editor with each page providing sections for editing
various configuration data. The multi page editor includes welcome, global settings,
account, group, services and testing pages. The welcome page is a quick start page that
provides links to the other pages of the configuration editor.

The simulator configuration is saved as an XML file with .wss file extension and the source
can be viewed with a text editor. More than one simulator configuration file can be created
per project. The editor is launched by double clicking on the configuration file or using
Open With -> Web Services Simulator Configuration editor context menu on the file.
Changes to a configuration file are not dynamically reflected in the running simulator. The
application server needs to be restarted to reflect the changes.
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Configuration editor — Global Settings page

_ —— —
- Deflnes gIObal Global Settings

simulator "~ Global Settings

Configurable global behavior for the Telecom Simulator.

configuration oeatconry, [risemwmea®
options L

[ Nested Group

Scheme: [g'ow ]
Domain Name: [ yourtelecom.com |

Netification Timeout: [30 ]

[0 Disable Paraliel Notifications

Welcome | Global Settings | Account | Group | Services | Testing|
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The global settings page of the simulator configuration editor contains settings global to
the simulator which include the default country, group and nested group support, and the
domain name for groups.

The Default country code is used for an address when a request comes into the

Simulator that does not already have a country code. The Group Support option indicates
whether requests with a Group URI will be allowed by services that optionally can accept a
Group URI as input. A request to process a group when it is not supported will result in a
Policy Exception being thrown by the simulator.

The Nested Group option indicates whether services that can accept a Group URI as input
will handle groups within groups. A request to process a nested group when it is not
supported will result in a Policy Exception being thrown by the simulator.

The Scheme name setting is prefixed to form the fully qualified group URI for groups
configured in the simulator. This value must comply with Request for Comments (RFC)
2396. The Domain name setting is appended to form the fully qualified group URI. This
value must comply with RFC 2396.

The Disable Parallel Notifications option is used by the Terminal Location and Terminal
Status services for debugging purposes. Enabling this option causes these services to
only accept one notification of a device change at a time to simplify testing with these
APIs.
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Configuration editor : Account page

* Provides 4 sections "= ——— 1
» Accounts g e
} Devices wf‘:::: Ouweschatie Otusy O Network Brror
» Device Configurati — e
evice Lonriguration e e
- Outence:
» Presence Attributes B—

- Presence Attributes
Presence detals for selected device

o N O L O

prvacy: [PrvecyQuet o] sohere: [Soheretione |

Kl

Other.
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The Accounts page of the simulator configuration editor provides 4 sections to add,
remove or change configuration data.

The four sections include Accounts, Devices, Device Configuration and Presence

Attributes. The Accounts section is used to add and remove accounts using the Add and
Remove buttons in this section. The Reset All button is used to reset existing account
values to the default values pre-defined as service policies in the tool. The Add and
Remove buttons in the Device section are used to add and remove devices from an
Account. An Account can have one or more devices. The Device configuration section has
several settings to configure values for a device which include:

- The status of a device
- The terminal location of the device expressed as latitude and longitude values
- The account balance of a device.

The presence attributes section has several configuration settings to configure the
simulation of the presence information of a device that include:

- Activity, which specifies whether the device is busy
- Place, which specifies the physical location of a device like at home or office.
- Privacy, which defines if the device owner is willing to share his presence information.
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Configuration editor : Group page

* Provides 2 sections
» Groups
» Group Configuration

Group Management
Groups ~ Configuration

Detals for the selected Group:
oo contacts Neme:  contacts

Subdoman:  sales

Avadabie Members

[Tel:+1-3335553000 [Te:+1-2225552000
Tel: +1-3338553001 Tel: +1-2225552001
Tel: +1-3335553002 Tel: +1-2225552002
Tel: +1-3335553003 Tel: +1-2225552003
Ted: + 14445554000
Tel: +1-4445554001
Tel: + 14445554002
Tel: +1-4445559003 Add>>

Welcome | Global Settings | Account | Grouo [ Services | Testing|

© 2007 IBM Corporation

The Group page provides 2 sections for group management.

Groups in a service provider network refer to the various lists of devices that a presentity
would have in their buddy list. There could be one or more groups listed per device, one or
more devices per group and one or more sub groups within a group.

The groups section of the group page provides controls to add or remove groups. The
configuration section is used to define the configuration of a group by adding or removing
devices from a group or adding or removing a sub group from a group.
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Configuration editor : Services page

* Provides 4 sections

; '8 e < N ==
» MMS Service S
Beh avior [~ MMS Service Behavior ~ Terminal Location Service Behavior
Configurable global behavior for MMS service. Configurable global behavior for Terminal Location service.
1 Maximum destinations: — Minimum Accuracy:
’ S M S 'SerVI Ce Acton (sx::: maximum destination exceeded) Minimum Acceptable Accuracy:
BehaVlor © Reject message for all destinations

© Only process up to maximum destination

Time policy (use): —Use current time -

&
P —
Miotodspiay: [Dolesips 7] prowsen|
M vt G

Rateof message devery:
~ SMS Service Behavior
Configurable global behavior for SMS service,

Mo desratons

Action (when maximum destination exceeded)

» Terminal Location
Service Behavior

» Terminal Status
Service Behavior

GPS coordnates for map center:

~ Terminal Status Service Behavior
Configurable global behavior for Terminal Status service.

Lattude:
© Reject message for all destinations

© Only process up to maximum destination Longae:

Rate of message devery:

O Transiate busy resuit to 'unreachable’

Wekome | Global Settings | Account | Group | Services [ Testing |
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Telecom Web services feature - Configuration and setup

The Services page provides 4 sections for configuring the behavior of 4 telecom services that include:
- Multimedia Message Service also know as MMS

- Short Message Service also known as SMS

- Terminal Location

- Terminal Status

The MMS and SMS services have the same configurable settings that include the maximum destinations
setting which defines the maximum number of destinations an MMS or an SMS message could be sent. The
Rate of message delivery setting which defines the number of devices an MMS or SMS message is sent per
second, for example a value of 10 requests that a message be delivered to 10 devices per second.

The terminal location service settings include the minimum accuracy, minimum acceptable accuracy, map to
display and the Global Positioning System (GPS) coordinates for the map center.

The minimum accuracy setting is the preferred accuracy that will be allowed to be requested by a Web
service client. Any requests for accuracy less than this value will result in a policy exception being thrown.
The minimum value, measured in meters, is the distance the device can be from the reported location.

The minimum acceptable accuracy setting is the preferred acceptable accuracy that will be allowed to be
requested by a Web service client. Any requests for an acceptable accuracy less than this value will result in
a policy exception being thrown. This must be equal to, or greater, than the minimum accuracy value.

The Map to display setting is the map that is displayed in the Map runtime view, explained in later slides.
This setting lets you select an existing geographical map from the list or select an external map in JPEG
format. The latitude and longitude values are set as degrees, minutes and seconds.

The Terminal status behavior section has one setting which is the “Translate busy to unreachable” setting.
This setting causes a device to show up in the service network with an unreachable status when it is in a
busy state.
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Configuration editor : Testing page

* Provides 3 sections

» Testing configuration

: . for——— =5
» Device behavior | resting configuration

Testing Configuration

» Service operation | mewrews
behaViOF Service Operation: | PlayAudio: PlayVoiceXmiMessage =l

~ Device Behavior ~ Service Operation Behavior
Configurable service behavior for the selected Device. Configurable behavior for the service operation.

Account: B Auo Cl Managemers
Device: [ Allan: +1-2225552000 [+ State Ouration (sec): [5__[%])

[ Message Cheding O

Service avalabiity: | Avadable >

Privacy: Vaid v

B e [t ]

Welcome | Global Settings | Account | Group | Services | Testng
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The Testing page provides settings that can enable or disable devices and define Parlay X
API error conditions.

The Service Operation drop down contains a list of API’s, grouped by Parlay X services,
which can be selected after checking the Enable Testing check box. Once an APl is
selected, you can configure the error conditions of this API for testing your application.

The Device Behavior section provides settings to select an Account and Device to test the
Service behavior for the selected API. The Message Checking settings are used to
customize various behaviors which include security, service availability, traffic
management and privacy for specific Parlay X API’s.

The Service Operation Behavior section provides settings to define the duration of an
audio call and to set error conditions for the call after audio is played. The "Process only
50% of the target” check box is a setting which limits 50% of the devices in a group to
process requests for group based APIs, such as GetStatusForGroup and
GetLocationForGroup.
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Simulator runtime views

= Launching runtime views

» Right click on server->Run Telecom Web Services
Simulator Client

» Window->Show View->Other->Telecom Simulator
» If disconnected from server, shows connect button to
reconnect
» Runtime views have these tabs:
» Activity, Call, Device, Group, Presence, Map

Telecom Web services feature - Configuration and setup © 2007 IBM Corporation

The simulator runtime views display the simulator configuration data and updates when
this data changes in the simulator during runtime. The runtime views are automatically
launched and connected to the simulator when the simulator is deployed on the
application server. The views can also be opened using the menu option Window -> Show
View -> Other -> Telecom simulator. To open a view or a set of views, select the views in
the telecom simulator category and click OK. Each runtime view has a connect button to
reconnect the view to the simulator if a connection is lost. There are six runtime views that
display all of the simulator configuration and runtime data. The six runtime views include:

Activity, Call, Device, Group, Presence and Map.
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Activity view

= Displays all Accounts and Devices defined in the
configuration

= Displays history of all events occurred on a device
in the simulator

= Data is not editable

[Problems | Tasks | Properties | servers | Database Explorer | snippets | Console (XTI

=@ Brown Motors - 1|
o Allan - Tel: +1-2225552000
il Betty - Tel: +1-2225552001
i Carl - Tel: +1-2225552002
il Debbie - Tel: +1-2225552003

@ @) Smith Textiles - 2

& @) Jones Cleaning - 3

The activity view displays all of the accounts and devices defined in the simulator
configuration being used by the Web services simulator. For each device in an account the
view displays the history of events that occurred on a device within the simulator. These
events are user triggered events to test Parlay X client applications for various Parlay X
services. Some of the events you would see in the activity view include:

For SMS messages, the message delivery time stamp, message type, and the SMS
message.

For MMS messages, the message delivery time stamp, message type, message subject,
and attachment type.

For Audio Call messages, the time, audio type, and appropriate parameters.

For Account transactions, the transaction time stamp, message type, operation, and
appropriate parameters

For Payment transactions, the time, message type, operation, and appropriate parameters

The figure in this slide shows a screen capture of the activity view where the simulator is
using the default simulator configuration. The top level elements in the activity view are

accounts and the second level elements are the devices in those accounts. The account
view is non-editable so simulator data can not be changed from this view. New accounts
and devices can be added using the Accounts page in the simulator configuration editor.
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Call view

= Displays active Third Party calls and their
connection status

= Data is not editable

'mu|rm|m|w|mmm|mu|cm|m|m
Name |_Connection Status | Interaction Status | Media |
= ECaISesion-:l

il Betty - Tel: +1-2225552001 Connected Idle
o Corl - Tel: +1-2225552002 Connected Idle

>
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The call view displays all of the calls placed between 2 devices, the call connection and
the interaction status between the 2 devices. The data in this view is not editable. This
screen capture shows a call that was placed between Betty and Carl with a connection
status of “Connected” and an interaction status of Idle.

WTT_Configuration.ppt Page 16 of 21



Group view
= Displays existing groups and members in each
group

= Members can be other groups (sub groups) or
devices

= Data is not editable

Problems | Tasks | Propertis | Servers | Database Explorer | Snippets | Console | Actiity | presence | cal [T TP

8 @igrow:cmtacts@sales.youtelecom.cmi
g Tel:+1-2225552000
-l Tel:+1-2225552001
- Tel:+1-2225552002
ol Tel:+1-2225552003

L
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The group runtime view displays all of the groups and its members as a tree view. The
members of a group can be devices or sub groups. The tree view only displays one
branch which includes the members of a group. This means that if a group contains
another group, the sub-groups members will not be expandable. However, that group will
appear elsewhere in the view, and can be expanded to reveal its members. Groups and
their members can be added through the Group Management configuration page in the
configuration editor, or by using the Group APIs.
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Device view

= Displays current simulator device data

= Data can be edited. Edited data is accessible to the
applications running in the simulator
= Save button

» persist device data changes into a simulator configuration
file

[m\rw]m%mlwmw\msjw{m!wmia\WM(m| &,
Name Status Lattude Location Time Distance Account Balance | P: Balance | Volume Balance Cal
Alan - Tel:4+1-2225552000 ~ Reachable ~ 0.107  -0.087  2005-01-1500:00:00GMT 150 [] 2,000.0 0.0 0.0 Pick Up
4 Betty - Tel: +1-2225552001 Reachable 0.095 0.094  2005-01-15 00:00:00 GMT 150 0 2,000.0 0.0 0.0 Pick Up
Carl - Tel: +1-2225552002 Reachable 0.097 0.011 2005-01-15 00:00:00 GMT 150 0 3,000.0 0.0 0.0 Pick Up
ol Debbie - Tel: +1-2225552003  Reachable 0.106 0.089 2005-01-15 00:00:00 GMT 150 0 200.0 0.0 0.0 Pick Up
# @ Smith Texties - 2

3§ Jones Cleaning - 3
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The device runtime view displays all of the accounts and devices along with the various
attributes of a device. The various device attributes include status, location, account
balance and whether the device is on a call. This view is editable and can be used to
simulate different device states just as in a real telecommunication network. This slide
shows a screen capture of this view. This view comes in handy for simulating a third party
call where both of the devices in a call show their status as “ringing”, “pick up” or “hang
up”. Note that checking the “Translate busy result to unreachable” check box in the
terminal status page of the simulator configuration editor, will cause the device to act as
"unreachable" if the device status is set to "busy".

The Map column in the view provides a check box that can be used if you want the device
to be displayed in the map view. The "Save As" button can be used to create a copy of the
currently running configuration.
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Map view

= Displays a map with movable devices represented by
images at their global positioning system (GPS)
locations

= GPS locations are used by terminal location service

P’mbhn Tasks | Properties | Servers | Database Explorer | Smppets | Consale | actty | presence | cat | Group Device @I T 3P0
s , — - — - >
i g h IFarmers | ] || Vi :l 5 S |
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The Map runtime view displays a background map with movable devices, represented by
images, at their Global Positioning System locations. To display an individual device on the
map, you need to perform two actions:

1. Select the “Display on map” check box and select an image for the device from the
“Device image” drop down on the accounts page of the configuration editor.

2. The map column for the device, in the device view, should be checked.

You can access device details like its location as longitudinal and latitudinal coordinates
and TEL URI by clicking on the device icon on the map. You can select devices on the
map with the mouse and drag them to different locations.

When Devices are moved on the map, their corresponding coordinates are updated in the
simulator, and the device runtime view reflects their new locations.

The icon used to represent the device on the map is contingent on the Device status.

When the Map view is loaded, the map, as specified in the simulator configuration file, is
loaded in the view.

WTT_Configuration.ppt Page 19 of 21



‘ IBM Software Group E

Presence view

= Displays the presence attributes of each device.

= Attributes include
» Activity, Place, Privacy, Sphere, Other
Problems | Tasks | roperties | Servers | Database Explorer | Sippets | Console | actity [~ TE eI, Call | Group | Device |

Name | Actvity | Place | Privacy | Sphere | Communication | Other |
& §) Brown Motors - 1
s Allan - Tel: +1-2225552000

PrivacyQuiet SphereNone  View/Edit | None |

ol Betty-Tel:+1-2225552001 ~ Avalable  Awport  PrivacyQuiet SphereNone  View/Edit None
Carl - Tel: +1-2225552002 Available Airport  PrivacyQuiet = SphereNone View [Edit None
Debbie - Tel: +1-2225552003  Avalable ~ Airport  PrivacyQuiet SphereNone  View/Edit None

$) smith Textles - 2
$ Jones Cleaning - 3
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The presence runtime view shows the presence attributes of all devices in all accounts.

The attributes include:

Activity, which tells the subscriber the device’s current status. For example: Away, Do Not
Disturb, and so on...

Place, which tells the subscriber the current location of the device. For example: Airport,
Mall, or a Train.

Privacy, which tells the subscriber the current privacy setting of the device.

Sphere, which tells the subscriber the device's current mode of operation. For example:
Work or Home

Other, which can be any new type of user defined presence attribute which is defined by
the Parlay X client application.
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